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MISSION AND VISION OF THE UNIVERSITY OF ARKANSAS AT PINE BLUFF  

Mission Statement 

The University of Arkansas at Pine Bluff (UAPB) is a public comprehensive HBCU 1890 

Land-Grant institution. The University embraces its land-grant mission of providing cutting 

edge research, teaching, outreach, and service programs that respond to social and economic 

needs of the state and region. Its mission is to promote and sustain excellent academic 

programs that integrate quality instruction, research, and student learning experiences 

responsive to the needs of a racially, culturally, and economically diverse student population. 

Ultimately, the University is dedicated to providing access and opportunity to academically 

deserving students and producing graduates who are equipped to excel through their 

contributions and leadership in a 21st century national and global community.  

Vision Statement 

The University of Arkansas at Pine Bluff will be widely recognized as the University of Choice 

for students, faculty, staff, and future employers of our students. UAPB will be renowned 

nationally and internationally for excellence in teaching, research, service, and outreach with 

exceptional academic programs and globally competitive students. As a pre-eminent 

land-grant institution, UAPB will enrich the lives of people in the Arkansas Delta and beyond. 

OVERVIEW OF THE UNIVERSITY 

The University of Arkansas at Pine Bluff is a historically black state supported land grant 

institution. Branch Normal College opened in September 1875. In 1927, the Governor appointed 

an independent Board of Trustees for the college. In 1929, the school was expanded into a standard 

four-year degree-granting institution and in 1933 was certified as a standard four-year college. In 

July 1972, Arkansas Agricultural, Mechanical and Normal College merged with the University of 

Arkansas and became the University of Arkansas at Pine Bluff.  

In keeping with its mission to provide “opportunity to academically deserving students” the 

University established admission standards in the fall of 2012. A high school grade point average 

of “C” and a composite ACT score of 19 are the general requirements for all students. Students 

graduating from Arkansas high schools without an overall grade point average of “C’’ and a 

composite ACT score of 19 may be granted conditional admission, with the understanding that the 

student must maintain an average of “C’’ or better in order to continue studies at the University.  

The University of Arkansas at Pine Bluff is located in Jefferson County in the south central part of 

the state. A majority of the institution’s students come from schools in the surrounding counties. 

Currently, 48% of the student body resides on campus and 52% commute. The institution’s student 

body is 91.23% Black or African American, 4.93% White, 1.81% Non-Resident Alien, 1.39% 

Hispanic, 0.41% Asian, 0.19% American/Alaska Native, and 0.04% two or more races. In the fall 

semester of 2015, approximately 2,666 students were enrolled with the University.  

The University of Arkansas at Pine Bluff offers thirty baccalaureate programs, six (6) technical 
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certificate programs, four (4) associate programs, eight (8) master’s programs, and one (1) Ph.D. 

program. Undergraduate degrees are awarded by four schools and one college: the School of 

Agriculture, Fisheries and Human Sciences; the School of Arts and Sciences; the School of 

Business and Management; the School of Education; and University College. Master of Science 

degrees are awarded in the School of Agriculture, Fisheries and Human Sciences (Aquaculture and 

Fisheries and Agricultural Regulations), the School of Arts and Sciences (Addiction Studies), and 

the School of Education (elementary/early childhood and secondary programs). The one Doctoral 

Program exists within the Department of Aquaculture and Fisheries.  

BRIEF HISTORY OF THE UNIVERSITY’S ASSESSMENT PLAN 

In the fall of 1991, the Interim Vice Chancellor for Academic Affairs commissioned a Committee 

on Assessment. The institution-wide committee, chaired by the Associate Dean for Academic 

Studies, consisted of eleven members including representatives from Comprehensive Testing, 

Institutional Research, five academic schools, University College, Placement, and the Registrar’s 

Office. The assessment plan prepared by the Committee on Assessment included: (1) 

university-wide assessment procedures for the First time Entering Freshmen students as mandated 

by the State Board of Higher Education; (2) a plan with procedures for assessment of the General 

Education (State Minimum) Core curriculum as mandated by the State Board of Higher Education; 

(3) English Proficiency Examinations (Sophomores/Juniors) as mandated by the State Board of 

Higher Education; (4) Comprehensive Examinations (Seniors) for content area from each 

degree-granting programs; (5) activities for teacher education majors (as mandated by the State 

Board of Education for Certification) and nursing majors (as mandated by the State and National 

Boards of Nursing for Licensure). The University formalized its assessment activities by adopting 

the Student Academic Assessment Plan in 2006. 

Since 2006, expectations and ideas regarding assessment have evolved. There is greater emphasis 

placed on explicitly identifying student learning outcomes, evaluating student learning outcomes 

using standardized rubrics, cataloging evidence of student learning outcomes, collection and 

analysis of assessment data, and use of assessment analyses in decision-making processes across 

academic and co-curricular units. In July 2015, the University hired a Director of Assessment.  

Several changes to the Student Academic Assessment Plan were implemented in response to the 

evolving assessment expectations mentioned above. 

 

The Office of Assessment is now the repository of data from standardized assessments at entry 

level (ACT, SAT, high school GPA, class rank), mid level (remedial course grades, Common 

Exam or English Proficiency Exam, CAAP Exam or University College Exit Exam, GPA at Exit 

of University College), exit level (Comprehensive Exam, Capstone Course Grade, Exit Interview, 

GPA at graduation), and follow up level (Alumni Survey, Employer Survey, Graduate School 

Survey, Unit Self Study). Each transition point represents a table in a relational database. As much 

as possible, data sources are associated with a specific student ID, facilitating the relationship 

among tables in the database and tracking of individual students longitudinally from admission to 

graduation and beyond. 

 

The University of Arkansas at Pine Bluff implemented LiveText as its assessment management 

system in the fall of 2015. The School of Education had formerly adopted LiveText to manage 
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student electronic portfolios. The initial steps of the LiveText rollout included hiring of a LiveText 

Administrator, a two-day LiveText training workshop (September 23-24, 2015), and adoption of 

four key assessments (two university-wide and two school/unit-wide) to be implemented in 

LiveText during the 2015-2016 academic year (see Appendix 1). In many, but not all cases, the 

student learning outcomes were associated with the Association of American Colleges and 

Universities Value Rubrics. Other standardized rubrics and a master curriculum map associated 

with the key assessments are under construction. 

 

LiveText is the repository of key assessments of University-wide learning outcomes (a three-year 

rotation of six learning outcomes, two outcomes assessed per year). The artifacts demonstrating 

the learning outcomes of the key assessments are archived in the system. The rubrics used for these 

learning outcomes are consistent across the University, allowing comparisons among units.  

 

The Director of Assessment is working with Graduate Coordinators from each of the M.Sc. 

programs and the Ph.D. program to identify entry, mid level, exit, and follow up transition points 

and assessments. These data are being entered into database tables specific to the respective unit.  

This effort effectively extends comprehensive assessment to all programs at the graduate level.  

 

LiveText is the repository for other assessments of learning outcomes defined by the units (School 

or Program, Department, or degree program). The artifacts demonstrating these learning outcomes 

are archived in the system. Learning outcomes defined for units higher than the degree program 

have consistent rubrics, again allowing comparisons among sub-units of the unit. 

 

The Office of Assessment is coordinating with units and support assessment activities for the 

Higher Learning Commission Assessment Report (Criteria 4), Assessment Annual Reports, and 

unit self studies necessary for unit accreditation or for Arkansas Department of Higher Education.  

The Office of Assessment is working with units to identify unit triggers for red or green flags (i.e. 

negative or positive alerts) and define feedback loops to improve learning outcomes. 

 

The Office of Assessment is responsible for working with non-academic units (e.g. Finance and 

Administration or Student Affairs) to develop assessments of unit-defined student learning 

outcomes consistent with the assessment plan. The Student Academic Assessment Plan was 

renamed the Student Assessment Plan to reflect the importance that co-curricular units play in 

student learning and success.  

 

The Assessment Director is responsible for authoring an Annual Assessment Report. This 

includes: summaries of data sources and learning outcomes at all transition points; analysis and 

interpretation of temporal trends in learning outcomes; analysis and interpretation of relationships 

among learning outcomes at different transition points; establishment of triggers for red or green 

flags; and clear definitions of feedback loops (triggered by red or green flags) leading to improved 

learning outcomes.   

 

The Assessment Office acquired, from ACT, electronic data representing all of the CAAP rising 

junior exam scores since fall of 2006. The Assessment Office also acquired all senior 

comprehensive exam scores since 1999. These data are being formatted for entry into a Microsoft 

Access database that includes approximately ten years worth of entry point data. Hence, the 
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Assessment Office is conducting analyses on temporal trends in learning outcomes and 

relationships among learning outcomes at different transition points (entry, mid-level, and exit) 

over the last ten years.        

 

LONGITUDINAL ASSESSMENT TRANSITION POINTS 

Entry Level 

 

Entry Level assessments include information provided to the University through the application 

process and initially entered into our Student Information System. These assessments include 

college entrance exam scores (ACT, SAT), high school GPA, class rank, and demographic data. 

The University College is the academic unit responsible for monitoring student performance on 

entrance examinations and placement in developmental courses designed to remove academic 

deficiencies. Section 19 of Act 1052 of the 1987 Arkansas Legislature requires all state-supported 

colleges and universities to institute a Freshmen Assessment and Placement Program.   

 

Students are assigned to developmental programs in reading, mathematics, and English on the 

basis of scoring below the State Minimum Standard on the ACT. Section 21 of Act 467 of 1989 

increased the required scores for the Freshman Assessment and Placement Program for 

implementation beginning with the Spring Semester, 1990.  

The University Freshmen Assessment and Placement Program is designed to ensure college 

freshmen are adequately prepared for college-level work. Students are placed in Developmental 

English 1310 when they score below 19 on the English portion of the Enhanced Act, below 40 on 

the TSWE, or below 42 on the ASSET Language Usage Test. Students are placed in 

Developmental Reading 1212 when they score below 19 on the reading portion of the Enhanced 

ACT, less than 340 on the verbal portion of the SAT, or below 41 on the ASSET reading Skills 

Test. Students scoring 19 or above on the ACT math subtest will be placed in College Algebra for 

STEM majors and Quantitative Literacy for Non-STEM majors. Students scoring 17 – 18 in 

Non-Stem majors can take the diagnostic test for placement in Enhanced Quantitative Literacy 

with a score of 80 or above. All other students scoring less than 80 on the diagnostic test and/or 

students scoring below math ACT of 18 will take the COMPASS pretest or an equivalent 

placement test.   

 

Mid Level  

Mid level assessments include performance in remedial classes (if necessary), standardized tests 

assessing English proficiency, performance in English Composition I & II, a standardized test 

assessing learning relative to the state minimum core for all baccalaureate programs, and GPA at 

the exit of University College. Since 2002, students take the Common Examination as part of 

English Composition I. Students who are unsuccessful in passing the Common Examination must 

enroll in English Seminar for additional assistance. The English Seminar does not replace the 

Common Examination. Transfer students who have completed English Composition I prior to 

enrollment at UAPB must take the English Proficiency Examination to fulfill this requirement.  

Transfer students should have completed the English Proficiency Examination by the second 
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semester of their sophomore year.  

The Office of Student Counseling, Assessment, and Development has the responsibility of 

assessing the academic achievement of students who have completed the University’s approved 

core of courses, which shall apply toward the general education core curriculum requirements for 

baccalaureate and associate degrees.  The plan for the State Minimum Core required for 

Baccalaureate Degrees utilizing the Academic Profile was approved by the State Board of Higher 

Education for implementation in the fall of 1993. The CAAP (Collegiate Assessment of Academic 

Proficiency) is the instrument to measure mastery of the core curriculum. Student who have 

acquired more than 60 credit hours, but have not taken the CAAP exam, are referred to the Office 

of Student Counseling, Assessment, and Development and required to take the University College 

Exit Exam. 

Exit Level  

Learning outcomes related to discipline-specific knowledge are assessed with Senior Assessments 

(see Appendix 3). In 2014, the University determined that students must pass their Senior 

Assessment with a score of 70% or higher. This requirement becomes effective for the freshman 

class entering the University in the Fall 2015 semester. Senior Assessments are administered 

within Departments.  

A Senior Assessment in the form of a Comprehensive Examination is divided into sections related 

to specific courses and subdivided into knowledge, skill, or competency areas, such that 

performance on the exam can be traced back to mastery of specific competency areas within 

specific courses. Comprehensive Examinations should be completed on Scantron Form No. 

F-1712-PAR-L-1. Scantron forms, along with an answer key, are brought to the Assessment 

Office. Scantron forms are scored, and the data, in electronic format, are returned to the 

Department.  

Some academic units are using standardized tests generated by accrediting agencies or other 

professional entities in place of a Comprehensive Examination. For example, the School of 

Education is using the ETS® Praxis exam and the School of Business is using the ETS® Major 

Field Test in Business. These types of standardized exams serve the same purpose as the 

Comprehensive Examination. The Assessment Office receives electronic scores from these 

standardized exams, which could be linked back to performance at other transition points using the 

Student ID as the common database element.  

A Senior Assessment can also take the form of a Senior Project. Departments must construct a 

rubric with 4 levels of accomplishment for each knowledge, skill, or competency demonstrated by 

the Senior Project. This rubric must be provided to the Assessment Office. The Senior Project will 

be assessed, by the Department, according to the rubric, using Scantron Form No. 

F-1712-PAR-L-1. Each knowledge, skill, or competency area is a separate question on the 

Scantron form. Each answer is equivalent to a performance level (i.e. A=4, B=3, C=2, and D=1). 

Scantron forms, along with an answer key, are brought to the Assessment Office. Scantron forms 

are scored, and the data, in electronic format, are returned to the Department (see Appendix 3).   
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The Assessment Office will be responsible for reporting completion of the Senior Assessment in 

the Colleague system, beginning in the fall 2015 semester.  

The assessment of students’ civic, social, cultural and economic attitudes, skills, values, and 

behavior are assessed through Exit interviews. The exact format of the Exit Interviews is up to 

each Department or degree program, but should be linked to other transition point assessments 

through a student ID.  Furthermore, the Assessment Office has requested Departments and degree 

programs include the following four questions in their Exit Interviews. 

1. Have you looked for a job? 

2. Have you looked for a job in your major field of study? 

3. Do you have a job? 

4. Do you have a job in your major field of study?  

5. Have you been accepted to graduate school?  

Follow Up Level 

Follow up assessments include satisfaction surveys of alumni, the community, employers, and 

graduate programs regularly accepting our graduates.  Satisfaction surveys assess alumni’s 

preparation for life, the world or work and/ or graduate studies. They measure programs and 

extra-curricular activities and their effects on the achievement of learning outcomes vital to a 

student’s complete development. Although satisfaction surveys are a transition point 

assessment, they are not tied to the other transition point assessments through a student ID and 

are not part of the longitudinal analyses described earlier. Nevertheless, they are an integral 

part of assessing whether academic units are producing graduates competitive in the job 

market and in graduate school.   

ASSESSMENT OF UNIVERSITY-WIDE STUDENT LEARNING OUTCOMES 

The Assessment Office has identified six student learning outcomes that are aligned with the 

mission and vision of the University. The learning outcomes are a subset of outcomes identified by 

the American Association of Colleges and Universities (AACU) in their Value Rubrics. They 

include Reading, Written Communication, Oral Communication, Critical Thinking, Problem 

Solving, and Foundations and Skills for Lifelong Learning. The Assessment Office is developing 

curriculum maps of key assessments of those learning outcomes across academic and co-curricular 

units. The Assessment Office plans to assess two of the six learning outcomes each year in a 3-year 

rotation (Appendix 2, pg 20). Key assessments of University-wide student learning outcomes are 

archived in LiveText and assessed according to the AAUC Value Rubrics. LiveText facilitates 

reporting on learning outcomes within and among academic units.     

ASSESSMENT OF STUDENT LEARNING OUTCOMES IN ACADEMIC UNITS 

The Assessment Office worked with each School (SAFHS, SAS, SBM, SOE, University College) 

to choose two School-wide student learning outcomes for assessment during the 2015-2016 

academic year (see Appendix 1). Each pair of School-wide student learning outcomes is aligned 

with goals articulated by the respective Schools. Schools are working with Departments to create 
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curriculum maps for each Department within the School, indicating key assessments relative to 

introduction, reinforcement, or assessment of mastery of the pairs of School-wide student learning 

outcomes. The key assessments are archived in LiveText and assessed according to the AAUC 

Value Rubrics or other rubrics standardized across Departments within Schools.  We anticipate 

that Schools will assess a larger set of student learning outcomes in the future, using LiveText to 

create standardized rubrics, archive the evidence of learning outcomes, and standardize the 

reporting format.  

 

Schools, Departments, and degree programs may have assessment needs relative to accreditation 

at the unit level. The Assessment Office works with accredited/licensed/state certified academic 

units to fulfill their assessment requirements and undertake program reviews for accreditation in 

two specific ways. The Assessment Office helps create curriculum maps, key assessments, and 

rubrics in LiveText related to professional standards outlined by accrediting agencies. The 

Assessment Office also helps units design database tables of unit-specific key assessments. If 

unit-specific key assessments are organized by Student ID, the relationships between transition 

point learning outcomes and discipline-specific learning outcomes can be examined. Examples of 

unit-specific key assessments would include portfolio assignments, capstone course assignments, 

professional licensure tests, or accrediting agency competencies.  

 

The Arkansas Higher Education Coordinating Board revised their policy for review of existing 

academic programs (AHECB Policy 5.12) in 2008. The policy states that, 

“Accredited/licensed/state certified programs will follow the usual review practices and schedule 

of the accrediting/approval body.” Academic units not program-specific accredited will be 

“externally reviewed every 7-10 years.” The Assessment Office helps academic units not program 

–specific accredited undertake self studies by creating curriculum maps, key assessments, and 

rubrics in LiveText related to unit goals, by designing database tables of unit-specific key 

assessments, and by assisting with analysis and interpretation of relationships within and among 

unit-specific key assessments and transition point key assessments. 

 

ASSESSMENT OF STUDENT LEARNING OUTCOMES IN CO-CURRICULAR UNITS 

Assessments occur in a variety of co-curricular units. Co-curricular units of the Academic Affairs 

division include Academic Skills and Developmental Services; TRiO Student Support Services; 

the Center for Teaching, Learning, and Advising; Honors College; Military Science, the Watson 

Memorial Library, Continuing Education, and the International Programs Office. The STEM 

Academy is a co-curricular unit in the division of Research, Innovation and Economic 

Development. Co-curricular units of the Student Affairs division include Career Services; Student 

Involvement and Leadership; and Student Counseling, Assessment, and Development. 

Co-curricular units in the Office of Enrollment Management and Student Success include the 

Student Success Center; and the LIONs program.  

Each of these co-curricular units works with the Assessment Office to identify specific student 

learning outcomes and key assessments of those outcomes. The Director of Assessment plans to 

provide access to LiveText to personnel in co-curricular units if necessary. Co-curricular units 

could determine key assessments, determine which students are involved with activities of the 

co-curricular unit, have students upload evidence of learning outcomes to LiveText, and use 

standardized rubrics to assess learning outcomes, just as this is done by course instructors. 
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However, assessment in co-curricular units will also include indirect methods of assessment, 

including surveys, focus groups, or case studies. In this way, all of the units on campus are 

included in the assessment of student learning outcomes.   

 

USE OF ASSESSMENT DATA TO IMPROVE STUDENT LEARNING 

The basic goal of assessment is to improve student learning. Students, instructors, and 

co-curricular personnel are all involved in the collection of data to support assessment of student 

learning. Adequate analysis and interpretation of assessment data is necessary to support the 

decision-making process at the University, School, Department, degree program, and co-curricular 

unit levels. The newly constituted Assessment Office includes a Director, responsible for all 

aspects of assessment at UAPB. One of the primary responsibilities of the Director is assessment 

data analyses and interpretation of analyses in conjunction with academic and co-curricular units. 

To facilitate the interpretations of assessment data analyses, two levels of assessment point people 

have been identified by Vice Chancellors, Deans, Directors, and Department Chairs. Level 1 

assessment point people generally have school-wide or unit-wide responsibilities for coordination 

of unit assessment activities, movement of school-wide data between the unit and the Assessment 

Office, and for interpretation of assessment data analysis with the Assessment Director, the unit 

head, and other unit personnel. 

 

For example, the level 1 point person in the School of Business and Management is an individual 

other than the Dean. This individual would coordinate assessment activities for the School of 

Business and Management, interact with the Assessment Director to move assessment data to the 

Assessment Office, and meet regularly (several times/year) with the Dean, Assessment Director, 

and perhaps Department Chairs, to interpret analyses of School of Business and Management 

assessment data. 

 

Level 2 assessment point people generally have department-wide responsibilities for coordination 

of departmental assessment activities. Level 2 assessment point people would be responsible for 

movement of departmental assessment data between the department and the Assessment Office, 

and for interpretation of assessment data analysis with the Assessment Director, the Department 

Chair, and instructors.  

 

The Assessment Office hired a LiveText Administrator in October 2015. This individual has 

responsibility for administration of the campus end of LiveText, for interacting with the LiveText 

Implementation Coordinator, and for training instructors, students, and other unit personnel in the 

use of LiveText. The LiveText Administrator is responsible for maintaining a Microsoft Access 

database with tables that include transition point (entry level, mid level, exit level) key assessment 

data and tables that include unit-specific key assessments from all academic and co-curricular 

units. In addition, the LiveText Administrator is responsible for maintaining the web pages for the 

Assessment Office.       
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Appendix 1.   University-wide, School-wide, and Co-curricular Unit (shaded in gray) Student Learning Outcomes for AY 2015-2016 

in the Division of Academic Affairs. 

School or Unit Department SLO 1 SLO 2 SLO 3 
(Univerisity-Wide) 

SLO 4 (University-Wide) 

Agriculture, 
Fisheries, and 
Human Sciences 

All QUANTITATIVE 
LITERACY Value Rubric:     
Explains information 
presented in figures and 
tables, summarizes data 
using diagrams, 
equations, tables and 
figures, formulates 
appropriate conclusions 
from data, and 
recognizes limits of 
conclusions which can 
be drawn from data   

INFORMATION LITERACY 
Value Rubric:    
Conducts efficient and 
effective searches of 
electronic information 
sources based on 
research questions, 
rates quality of 
information according 
to discipline appropriate 
standards, organizes, 
summarizes, and 
synthesizes information 
from searches, cites 
information sources in 
an appropriate and 
ethical manner. 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 
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Arts and Sciences All INFORMATION LITERACY 
Value Rubric:    
Conducts efficient and 
effective searches of 
electronic information 
sources based on 
research questions, 
rates quality of 
information according 
to discipline appropriate 
standards, organizes, 
summarizes, and 
synthesizes information 
from searches, cites 
information sources in 
an appropriate and 
ethical manner. 

TEAMWORK Value 
Rubric:    Critiques 
the relative merits of 
alternative ideas within 
a group, while 
remaining respectful of 
all contributions, 
engages multiple 
individuals by building 
on or synthesizing 
disparate ideas, works 
independently and 
collectively to meet 
group objectives, 
addresses conflict in 
constructive manner. 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 

 Addiction 
Studies (grad) 

Examine behaviors and 
values of clients, 
consider circumstances 
and external pressures, 
and develop appropriate 
treatment plans.   

Research community 
demographics, consider 
social norms and values, 
match circumstances 
with theories of 
avoidance and 
deterrence, and develop 
appropriate prevention 
plans. 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 
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Business and 
Management 

Both CRITICAL THINKING 
Value Rubric:    
Relates issues relevant 
to a problem clearly and 
completely, selects and 
uses appropriate 
information to analyze 
and interpret different 
aspects of a problem, 
constructs a solution 
that accounts for the 
complexities of a 
problem, and  
evaluates the 
implications and    
+``consequences of 
favored and alternative 
solutions to a problem.  

ETHICAL REASONING 
Value Rubric:    
Analyzes core beliefs 
regarding ethical 
behavior in discipline, 
decides appropriateness 
of practices based on 
different ethical 
perspectives and 
theories, and evaluates 
the assumptions and 
implications of 
alternative ethical 
behaviors in discipline. 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing. 

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 
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Education Both 
FOUNDATIONS AND 

SKILLS FOR LIFELONG 

LEARNING Value Rubric:  

Lifelong learning is “all 

purposeful learning 

activity, undertaken on 

an ongoing basis with 

the aim of improving 

knowledge, skills and 

competence”. An 

endeavor of higher 

education is to prepare 

students to be this type 

of learner by developing 

specific dispositions and 

skills. 

 

INTERCULTURAL 
KNOWLEDGE Value 
Rubric:    Recognizes 
how personal 
experiences shape 
cultural biases, 
evaluates the influences 
of history, politics, 
economics, beliefs, and 
practices on behaviors 
among cultures, 
demonstrates empathy 
with other cultural 
groups, facilitates 
communication that 
demonstrates a 
multicultural 
perspective   

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 
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University College General 
Studies 

INFORMATION LITERACY 
Value Rubric:    
Conducts efficient and 
effective searches of 
electronic information 
sources based on 
research questions, 
rates quality of 
information according 
to discipline appropriate 
standards, organizes, 
summarizes, and 
synthesizes information 
from searches, cites 
information sources in 
an appropriate and 
ethical manner. 

Locate online and print 
materials to explore 
career opportunities, 
compare vocational 
requirements to 
personal aptitude and 
temperament, and 
make informed 
decisions regarding 
vocations 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 

 Basic 
Academic 
Services 

QUANTITATIVE 
LITERACY Value Rubric:     
Explains information 
presented in figures and 
tables, summarizes data 
using diagrams, 
equations, tables and 
figures, formulates 
appropriate conclusions 
from data, and 
recognizes limits of 
conclusions which can 
be drawn from data   

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  
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University College Academic 
Skills and 
Development 
Services 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  

Searches for definitions 
of unfamiliar words, 
uses thesaurus to 
increase vocabulary, and 
practices an expanded 
vocabulary in oral and 
written context. 

Student Learning 
Objectives: Know how 
to read  actively,  
learn from college 
textbooks, build a 
stronger reading 
vocabulary,  locate 
main ideas, identify 
supporting details, 
understand implied 
main ideas, recognize 
basic organizational 
patterns,  read and 
think critically, and  
prepare to take 
standardized test 

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 

 Trio Student 
Support 
Services 

QUANTITATIVE 
LITERACY Value Rubric:     
Explains information 
presented in figures and 
tables, summarizes data 
using diagrams, 
equations, tables and 
figures, formulates 
appropriate conclusions 
from data, and 
recognizes limits of 
conclusions which can 
be drawn from data   

WRITTEN 
COMMUNICATION 
Value Rubric:    
Writes with organization 
and purpose on subject, 
using credible sources 
and arguments, and 
following style and 
grammar appropriate 
for the discipline. 

READING Value Rubric:    
Comprehends written 
material from their 
discipline, judges the 
material for quality and 
utility, and critiques the 
material orally during a 
discussion and in 
writing.  
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Honors College Honors 
College 

Demonstrates change in 
attitudes and beliefs 
because of participation 
in community service, 
perceives connection 
between academic 
endeavors and civic 
engagement, 
demonstrates 
participation and 
leadership in civic 
activities. 

Identify 
post-baccalaureate 
opportunities, complete 
applications to graduate 
school, professional 
school, medical or law 
school, schedule and 
complete study routine 
for standardized tests, 
register for and take 
standardized test 
required for 
post-baccalaureate 
study. 

    

            

Military Science Military 
Science 

Demonstrate leadership 
by issuing appropriate 
commands during drills, 
instill confidence in 
subordinates by 
outlining solutions to 
problems confronting 
teams during group 
exercises, and perform 
leadership roles under 
simulated stressful 
circumstances. 

Conduct self according 
to appropriate military 
behavior in formal and 
informal settings, 
display correct military 
comportment and 
posture under a variety 
of circumstances, and 
demonstrate knowledge 
of Army customs and 
courtesies in simulated 
interactions with 
members of superior 
and subordinate rank. 
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Center for 
Teaching and 
Learning and 
Advisement 

Center for 
Teaching and 
Learning and 
Advisement 

Demonstrates ability to 
log into the Blackboard 
Learning Management 
System, visit a specific 
course, and send or 
receive messages within 
Blackboard 

Demonstrate ability to 
submit an assignment 
within the Blackboard, 
look up final grade on 
the assignment, and 
acquire feedback from 
instructor 
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Appendix 2.   Three-Year Rotation of University-wide Student Learning Outcomes 

Reading Year 1 

  Written Communication Year 1 

  Oral Communication 

 

Year 2 

 Critical Thinking 

 

Year 2 

 Problem Solving 

  

Year 3 

Foundations and Skills for Lifelong Learning 

  

Year 3 
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Appendix 3. Senior Assessments 

Senior assessments represent a transition point key assessment of discipline-specific knowledge, 

skills, and competencies. Together with entry-level and mid-level key assessments, senior 

assessments are critical to longitudinal assessment of student learning outcomes. Recent changes 

in policies surrounding senior comprehensive exams include the requirement to pass (not just take) 

the exam and a baseline of 70% for passing. Another change involves administration and grading 

of the senior comprehensive exam. Until recently, comprehensive exams were administered and 

graded by Mr. Thompson, an employee in the School of Education. Scores were reported directly 

on the Scantron answer sheet and then transcribed into excel spreadsheets for distribution to 

departments and schools. Mr. Thompson is no longer with the University and responsibility for 

administration and grading of the senior comprehensive exam needs to change.  

As of the fall 2015 semester, responsibility for administration of the senior comprehensive exam 

will belong to the academic departments. We urge each department to bring their comprehensive 

exams up to date. We urge departments to create unique comprehensive exams for every 

concentration within a degree program, based on skills and competencies that all students within a 

concentration should acquire.  For example, The Agriculture Department has two degree 

programs, Agricultural Sciences and Regulatory Science.  There are, however, several 

concentrations within the Agricultural Sciences degree program (e.g. Agricultural Business, 

Animal Science, Plant and Soil Science, etc).  With different senior comprehensive exams for 

each concentration, Agricultural Business students get a comprehensive exam unique to the 

Agricultural Business concentration, while Animal Science students get a different comprehensive 

exam unique to the Animal Science concentration.  Conceivably, some of the questions on the 

Agricultural Business and Animal Science exams would be the same, as the two concentrations 

might require a course or competency common to both concentrations. 

A manner of test organization allowing for assessment of learning will be required. Departments 

probably have generated sets of questions from different classes or competency areas. We urge 

departments to group four questions within a competency or knowledge area (See Creating a 

Senior Assessment in the form of a Senior Comprehensive Exam, below). For example, a 

comprehensive exam constructed in Industrial Technology might have questions on robotics, 

electronics, and mechanics. Questions 1-4 could be robotics questions, questions 5-8 could be 

electronics questions, and questions 9-12 could be mechanics questions. The overall exam score 

would represent learning relative to all knowledge within Industrial Technology, but the sub score 

on questions 1-4 represents robotics knowledge, ostensibly learned in robotics classes. Using such 

a scheme, sub score performances can be linked to specific competencies, knowledge areas, or 

courses, making the comprehensive exam considerably more informative. 

Recently, a Scantron machine from the Nursing Program was transferred to the Assessment 

Office. This machine should allow the scores on Scantron answer sheets to be written directly to a 

digital file. If the student’s name and Student ID (flush left) are reported on the Scantron answer 
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sheet, the record of each student’s performance on the comprehensive exam can be entered directly 

into a database table. Sub scores could be easily calculated and reported to departments, along with 

the number of questions attempted, number of correct answers, and percent of correct answers. We 

urge Departments to use the Office of Assessment to have senior comprehensive exams graded. 

It seems reasonable to substitute performance on a standardized licensure exam for a senior 

comprehensive exam. The University recognizes that accrediting bodies using standardized tests 

have explicit criteria regarding passing scores. Any Department that uses a standardized test, per 

accrediting requirements, will use the criteria recognized by the accrediting agency to determine a 

passing performance. To use the results of the standardized licensure exam as the exit-level 

transition point assessment, one must be able to link performance at this transition point to 

performance at earlier transition points (entry-level and mid-level) through a common unique 

identifier such as student ID. Longitudinal analysis at entry, mid, and exit-level are not possible if 

one cannot link the exit-level key assessment (i.e. the comprehensive exam) to earlier key 

assessments. Standardized licensure exam scores should be reported to the department in a digital 

format to allow incorporation of the scores into existing databases without transcription. Finally, 

just as with comprehensive exams created and administered by departments, standardized 

licensure exams are most useful when they are organized to allow assessment of learning in 

specific competencies or content areas, rather than simply providing a pass/fail or percent correct 

answers reporting format. 

Some units would prefer a senior assessment in the form of a senior project. This would be 

acceptable, provided certain conditions are met. The senior project should be designed to allow 

assessment of a comprehensive range of knowledge, skills, or competencies. A department should 

develop a 4-point grading rubric for a senior project. Each row of the rubric should correspond to a 

specific skill or competency demonstrated by the senior project. Each cell of the rubric should 

correspond to a clearly-defined level of accomplishment, where level 4 = mastery of the skill or 

competency. Departments are responsible for defining the KSC areas and for assessing the senior 

project using a Scantron form (see Creating a Senior Assessment in the form of a Senior 

Project, below). The Scantron sheet and the list of corresponding KSC areas would be sent to the 

Assessment Office. One Scantron sheet (i.e. Senior Project assessment) should be generated for 

each graduating senior.  

Students completing their degree at the end of a summer session should have taken the Senior 

Assessment during the preceding spring term. A tentative timeline for Senior Assessments should 

include: 

1. Revisions of a Senior Assessment (Senior Comprehensive Exam or Senior Project Rubric) 

should be completed by the last day of instruction the semester before they are 

implemented. Electronic copies of the Senior Comprehensive Exam (Instructor Copy) or 

the Senior Project Rubric should be provided to the Department Chair, Department 

Proctor/Assessor, and Assessment Office by the aforementioned deadline.  
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2. No later than September 10 or January 31, the date/time/location of a Senior 

Comprehensive Exam administration or the Senior Project due date should be announced 

by Departments.  

3. Bi-weekly reminders of exam date or project due date should be provided throughout the 

semester. 

4. No later than October 20 or March 15, the first administration of the Senior Comprehensive 

Exam or the Senior Project due date should occur. 

5. By October 21 or March 16, the Scantron forms of Senior Comprehensive Exams and an 

answer key should be brought to the Assessment Office. Comprehensive Exams will be 

graded and data returned to Departments by October 31 or March 25. 

6. No later than October 31 or March 25, the Senior Project should be assessed, according to 

the rubric, by the Department Assessor or capstone course instructor. A Senior Project 

assessment (on a Scantron form) should be submitted to the Assessment Office by October 

31 or March 25. A separate assessment (i.e. Scantron form) should be submitted for each 

graduating senior.  

7. No later than November 19 or April 15, a second administration of a Senior 

Comprehensive Exam should occur, or the due date for a revision of a Senior Project 

should occur (once students are required to pass the Senior Assessment). 

8. By November 20 or April 16, Scantron forms of Senior Comprehensive Exams and answer 

keys for the second administration should be brought to the Assessment Office. 

Comprehensive Exams will be graded and data returned to Departments by November 25 

or April 20.  

9. Assessments of a revised Senior Project should be brought to the Assessment Office by 

November 25 or April 20. 

10. The Assessment Office enters results of Senior Assessments into Colleague by  

November 30 or April 25. 

For policy questions regarding these changes, please contact the Interim Vice-Chancellor for 

Academic Affairs. For questions regarding test formatting, grading, grade reporting, or assessment 

with comprehensive exam results, please contact the Director of Assessment. 
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Creating a Senior Assessment in the form of a Comprehensive Exam 

This procedure assumes that each degree program has a multiple choice comprehensive exam in 

MS Word format. It assumes that a separate answer key exists for the exam.  

1. On the exam, highlight each correct answer and change the font color to red (see 

2015_AQFI Senior Comp Exam Questions with correct answers in red). 

2. Group your questions by class in which the material is covered (if this has not already been 

done). 

3. Type in the name of the class as a header for each section. Change the color of the font of 

the class name to green. 

4. Group questions within each class by knowledge, skill, or competency (KSC) area. 

5.  Type in words to identify or describe each KSC area. Change the color of the font of the 

KSC area to blue. 

6. Choose four questions to represent each KSC area (Choosing four questions allows cross 

comparisons with Senior Assessments in the form of Projects graded with a 4-point rubric). 

7. Tests can be up to 200 questions (50 KSC areas) long. 

8. Check questions numbering and format. 

9. Select File=> Save As=> Append the word “_instructor” to the filename and save the file 

(see file 2015_AQFI Senior Comp Exam_Instructor). Students should never see this file! 

10. Archive electronic copies of the instructor version of the comprehensive exam with the 

chair, the Assessment Office, and the individual in your department proctoring the exam. 

11. Select File=> Save As=> Append the word “_student” to the filename and save the file. 

12. Delete all green and blue fonts. 

13. Choose Home=>Select=>Select All. Change the red font to black. 

14. Re-check numbering and format. 

15. Save the file again (see file 2015_AQFI Senior Comp Exam_Student) 

16. Print out a hard copy of the exam for each of your graduating seniors. 

17. The department may acquire Scantron answer sheets (Scantron Form No. 

F-1712-PAR-L-1) from the Assessment Office or on their own. 

18. Proctor should fill out the answer key on a Scantron form using the instructor file. 

19. Proctor administers the exam by providing each student a copy of the exam and a Scantron 

answer sheet. 

20. Students fill out Scantron form using No. 2 lead pencil. Student should include their UAPB 

ID and their Last and First Names.  

21. When students have completed the exam, they return the Scantron sheet and the hardcopy 

of the comprehensive exam to the proctor. 

22. Proctor takes the Scantron answer key and the Scantron answer sheets to the Assessment 

Office. 

23. The Assessment Office grades the comprehensive exam and provides an electronic version 

of the results to the department as an excel spreadsheet. 
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24. The excel spreadsheet will be organized one student per row. Fields (i.e. columns) in each 

row will include Degree Program, Student Last Name, Student First Name, Student ID, 

followed by student’s performance on each question (1=right, 0=wrong). The last column 

of the row will be the percent of correct answers a student provided (i.e. the exam score).  

25. Departments will be responsible for notifying Academic Records regarding which 

individuals have taken the exam and their performance.   
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Creating a Senior Assessment in the form of a Senior Project 

If a Senior Assessment takes the form of a Senior Project, then the following procedures should be 

followed.  

1. The department will generate a rubric for the Senior Project based on a 4-point competency 

scheme (see Figure 1, below).  

2. The department will identify all the knowledge, skill or competency (KSC) areas addressed 

by the Project. Each KSC area represents a row (or element) of the rubric. Each KSC area 

should be adequately described in the numbered cells of the second column of the rubric. 

3. The 4-point scheme is necessary to allow cross comparisons with Senior Comprehensive 

Exams with 4 questions/KSC area.  

4. The department should generate verbiage in each cell of the rubric which clearly describes 

the level of learning displayed by the student receiving that score. Level 1 represents the 

poorest level of learning in the KSC area, while level 4 represents the highest level of 

learning. 

5. When the rubric is complete, an electronic copy of the Project Rubric should be archived 

with the chair, the Assessment Office, and the individual in your department assessing 

Senior Projects. 

6. The assessor should complete one Scantron answer sheet for each student undertaking a 

Senior Project.  

7. The department may acquire Scantron answer sheets (Scantron Form No. 

F-1712-PAR-L-1) from the Assessment Office or on their own. 

8. The assessor should fill in the Scantron form using No. 2 lead pencil. The assessor should 

include the senior’s UAPB ID and their Last and First Names.  

9. The assessor then assesses each KSC area addressed by the Project. The first KSC area of 

the rubric (i.e. row 1 of the rubric) should be assessed using the boxes for Question 1 on the 

Scantron sheet (A=Level 4, B=Level 3, C=Level 2, and D=Level 1).  

10. The number of questions answered on the Scantron sheet should equal the number of KSC 

areas (i.e. rows) in the rubric. 

11. The assessor takes the Scantron answer sheets to the Assessment Office. 

12. The Assessment Office records the results of the Senior Project assessment and returns the 

results to the department as an excel spreadsheet. 

13. The excel spreadsheet will be organized one student per row. Fields (i.e. columns) in each 

row will include Degree Program, Student Last Name, Student First Name, and Student ID, 

followed by student’s numerical performance on each KSC area. The last column of the 

row will be the average of all the point scores in each KSC area divided by 4 times 100 (i.e. 

the overall assessment of the Senior Project on a percentage basis).  

14. Departments will be responsible for notifying Academic Records regarding which 

individuals have completed a Senior Project and their performance.   
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Figure 1. Senior Project Rubric 

 
Level 4 (4 pts) Level 3 (3 pts) Level 2 (2 pts) Level 1 (1 pt) 

Complete 

description of first 

knowledge, skill or 

competency 

Description of 

complete 

mastery of first 

KSC goes here 

Description of 

partial mastery 

of first KSC 

Description of 

minimal 

mastery of first 

KSC 

Description of 

no mastery of 

first KSC 

Complete 

description of 

second knowledge, 

skill or competency   

Description of 

complete 

mastery of 

second KSC 

Description of 

partial mastery 

of second KSC 

Description of 

minimal 

mastery of 

second KSC 

Description of 

no mastery of 

second KSC 

Complete 

description of third 

knowledge, skill or 

competency 

Description of 

complete 

mastery of 

third KSC 

Description of 

partial mastery 

of third KSC 

Description of 

minimal 

mastery of 

third KSC 

Description of 

no mastery of 

third KSC 

Complete 

description of fourth 

knowledge, skill or 

competency 

Description of 

complete 

mastery of 

fourth KSC 

Description of 

partial mastery 

of fourth KSC 

Description of 

minimal 

mastery of 

fourth KSC 

Description of 

no mastery of 

fourth KSC 

Complete 

description of fifth 

knowledge, skill or 

competency 

Description of 

complete 

mastery of 

fifth KSC 

Description of 

partial mastery 

of fifth KSC 

Description of 

minimal 

mastery of 

fifth KSC 

Description of 

no mastery of 

fifth KSC 

Complete 

description of sixth 

knowledge, skill or 

competency 

Description of 

complete 

mastery of 

sixth KSC 

Description of 

partial mastery 

of sixth KSC 

Description of 

minimal 

mastery of 

sixth KSC 

Description of 

no mastery of 

sixth KSC 

Complete 

description of 

seventh knowledge, 

skill or competency 

Description of 

complete 

mastery of 

seventh KSC 

Description of 

partial mastery 

of seventh 

KSC 

Description of 

minimal 

mastery of 

seventh KSC 

Description of 

no mastery of 

seventh KSC 

Complete 

description of eighth 

knowledge, skill or 

competency 

Description of 

complete 

mastery of 

eighth KSC 

Description of 

partial mastery 

of eighth KSC 

Description of 

minimal 

mastery of 

eighth KSC 

Description of 

no mastery of 

eighth KSC 

Add more rows as 

necessary. Number 

of rows equals 

number of ksc 

demonstrated by the 

senior project          

 

 

    

      

 


